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 Millî Eğitim Bakanlığınca ücretsiz olarak verilmiştir. 

 PARA İLE SATILMAZ. 

amacıyla hazırlanmış bireysel öğrenme etmek öğrencilere rehberlik 

materyalidir. 

 Bu modül, mesleki ve teknik eğitim okul/kurumlarında uygulanan Çerçeve 

Öğretim Programlarında yer alan yeterlikleri kazandırmaya yönelik olarak 
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AÇIKLAMALAR 
 

 
ALAN Makine Teknolojisi 

DAL/MESLEK Bilgisayar Destekli Endüstriyel Modelleme 

MODÜLÜN ADI 
Katı-Yüzey Modelleme Ve Görsellik 

 

MODÜLÜN TANIMI 

Üç boyutlu çizim ortamında temel çizim komutlarını 

Kullanarak çizim yapma ile ilgili bilgi ve becerilerin 

kazandırıldığı bir öğrenme materyalidir. 
SÜRE 40/32 

ÖN KOŞUL Bu modülün ön koşulu yoktur. 

YETERLİK Katı-yüzey modelleme ve görsellik işlemlerini yapmak 

 

 

 

 

 
MODÜLÜN AMACI 

Genel Amaç 

Gerekli ortam sağlandığında bilgisayar ortamında üç boyutlu 

çizim komutlarını kullanarak katı ve yüzey modelleme 

yapabilecek ve gölgelendirme ve kaplama işlemleri 

komutlarını kullanabileceksiniz. 

Amaçlar 

1. Katı modelleme komutlarını doğru kullanarak çizim 

yapabileceksiniz. 

2. Yüzey modelleme komutlarını doğru kullanarak 

çizim yapabileceksiniz. 

3. Katı-yüzey modellerine uygun gölgelendirme ve 

kaplama işlemleri yapabileceksiniz. 

EĞİTİM ÖĞRETİM 

ORTAMLARI VE 

DONANIMLARI 

Ortam: Bilgisayar destekli çizim ortamı, Atölye ortamı 

Donanım: Bilgisayar destekli üç boyutlu çizim 

programı, yenilenebilir enerji teknolojilerine ait model 

parçaları ve teknik Görsel çizimleri 

 
 

ÖLÇME VE 

DEĞERLENDĠRME 

Modül içinde yer alan her öğrenme faaliyetinden sonra verilen 

ölçme araçları ile kendinizi değerlendireceksiniz. Öğretmen 

modül sonunda ölçme aracı (çoktan seçmeli test, doğru-yanlış 

testi, boşluk doldurma, eşleştirme vb.) kullanarak modül 

uygulamaları ile kazandığınız bilgi ve 
becerileri ölçerek sizi değerlendirecektir. 

AÇIKLAMALAR 
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GİRİŞ 

 
 

Sevgili Öğrenci, 
 

“Katı-Yüzey Modelleme ve Görsellik Modülü” ile “Yenilenebilir Enerji Teknolojisi Alanı’nda 

iş ve işlemlerinizi gerçekleştireceğiniz üç boyutlu çizim programını tanıyacak, kullanım alanlarını 

ve tekniklerini öğreneceksiniz. 

 

Bilgisayar teknolojisi teknik çizimler içinde yerini almış ve bilgisayar desteği ile çizim 

yapabilen çizim programları geliştirilmiştir. 

 

Rüzgâr ve güneş santrali teknolojilerinde üç boyutlu çizim programlarını kullanmak zaman, 

tasarım ve imalat maliyetlerini düşünülürse zorunluluk haline gelmiştir. 

 

Bu modül; bilgisayar destekli tasarım ve modelleme programı ile katı ve yüzey modelleme 

tekniklerini kullanmanızı, bu yöntemlerle de katı ve yüzey modellerin oluşturulması veya oluşturulan 

modellere gölgelendirme ve kaplama özelliği katma konularında size yardımcı olacaktır. 

 

Modülü başarı ile tamamladığınızda ve kendinizi konu hakkında geliştirdiğinizde yenilenebilir 

enerji sektöründe çalışabilecek yeterliliğe sahip olacaksınız. 

 

GİRİŞ 
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ÖĞRENME FAALİYETİ-1 
 

 

 

 

 

Bu öğrenme faaliyeti sonunda katı modelleme komutlarını kullanarak üç boyutlu çizim 

yapabileceksiniz. 

 

 

 

 

 Katı modellemenin nerelerde kullanıldığını araştırınız. 

 Yaşadığınız yerde bulunan imalat ile ilgili işletmeleri gezerek burada kullanılan katı 

modelleme ile ilgili programlar hakkında bilgi alınız. 

 İnternet ve kitaplarınız yardımıyla üç boyutlu çizim program çeşitlerini, nasıl 

kullanıldıkları ilgili video ve doküman araştırması yapınız. 

 

1. KATI MODELLEME KOMUTLARI 
 

Tasarım amacı, modelin değiştirildiğinde nasıl davranacağına dair yaptığınız plandır. Örneğin, 

içinde kör delik bulunan bir “boss” modellediyseniz,” boss” hareket ettiğinde, delik de hareket 

etmelidir. Benzer şekilde, eşit aralıklı altı delikten oluşan dairesel delik çoğaltması modellediyseniz, 

deliklerin sayısını sekize çıkardığınızda, delikler arasındaki açıların otomatik olarak değişmesi 

gerekir. Modeli oluşturmak için kullandığınız teknikler, ne tip ve nasıl bir tasarım amacı 

yakalayacağınızı belirler. 

 

Önceleri sadece teknik Görsel hazırlama amacıyla kullanılan CAD programları; günümüzde 

3D tasarımlama ve tasarım aşamasında bulunan bir makinenin çalışmasını animasyona dönüştürerek 

bilgisayar ortamında çalışmasını görmeyi mümkün kılmaktadır. 

 

Kullanıcı bu üç boyutlu tasarım programı ile her türlü ürün tasarımını bilgisayarın 

kolaylıklarını kullanarak hızlı bir şekilde 3 boyutlu çizim yapabilir. 

 

Bu program akıllı ve kolay montaj uygulamaları ile son derece hızlı montaj yapılmasını sağlar. 

Bunun dışında sac parçaların açılımını yaparak uzama miktarları hesaplanabilir. Ayrıca katı objeler 

kullanılarak kesme, yırtma veya şekillendirme işlemleri yapılabilmektedir. 

 

Yapılmış olan tüm bu işlemler IGES, DXF, DWG, SAT(ACIS), STL, STEP, F3D, F2D, F3Z, 

OBJ, FBX, Sketchup ve SMT dosya formatlarıyla kayıt veya transfer yapılabilir. 

 

Tasarlanmış unsurlar 2 boyutlu çizime (sketch) dayalı unsurlardır. Genel olarak, bu çizim, 

ekstrüzyon, döndürme, süpürme ya da loft uygulama yolu ile bir katıya dönüştürülür. Bir unsurun 

ölçülendirilmesinde, çizim geometrisiyle ilişkili ölçülerle birlikte, unsurun kendisi ile ilişkili ölçüleri 

bulunur. 

Bu program, temel olarak birbirleriyle ilişkili üç dosyadan oluşmaktadır. Bu dosyalar; 

 Body (Parça) Dosyası: Oluşturmuş olduğunuz 2B çizimi katıya dönüştürdüğünüzde, 

ortaya çıkan tüm tasarımlar “body” olarak isimlendirilir. 

ÖĞRENME FAALİYETİ-1 

ÖĞRENME KAZANIMI 

ARAŞTIRMA 
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 Component (Bileşen/Montaj) Dosyası: Montaj dosyasıdır. Bileşen haline getirdiğiniz 

tüm tasarım dosyaları arasında montaj ilişkisi atayabilirsiniz 

 Teknik Görsel Dosyası: Parça ya da montaj dosyanızın teknik dokümanlarının 

hazırlandığı dosyaya denir. 
 

Autodesk Fusion 360 programını çalıştırıp bir dosya açtığınızda aşağıdaki çizim ekranı 

görülecektir. 

 

Görsel 1.1: Unsur ekranı 

 

Görsel 1.2: Çizim ekranı 
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 Standard Araç Çubukları 

 

Show Data Panel (Veri Panelini Göster) 

Bu komut ile bulut sistemde bulunan projelerinize ulaşabilirsiniz. 

Projelerinizin içerisinde bulunan tasarımları açabilirsiniz. Projenize çalışma 

arkadaşlarınızı davet edebilirsiniz. 

 

File (Dosya) 

File simgesi yanındaki ok işaretine tıkladığınızda karşınıza birçok komut  

görebileceğiniz bir liste çıkacaktır. Bu menüde; yeni bir tasarım sayfası 

açmak, teknik Görsel oluşturmak, bulut sistemde bulunan dosyalarınızı 

açmak, bilgisayarınızdan 3B objeleri veya teknik Görsel uzantılı dosyaları 

bulut sisteme aktarmak, tasarımınızı buluta kaydetmek, tasarımınızı 

bilgisayarınıza kaydetmek gibi komutlara file menüsünden ulaşabilirsiniz.  

 

Save (Kaydet) 

Bu komuta tıkladığınızda tasarımınızı bulut sistem üzerinde  bulunan  

projelerinizin içerisine kaydedebilirsiniz. Bu komut ile tasarımınızı 

bilgisayarınıza kaydedemezsiniz. Bilgisayarınıza kaydetmek için 

File>Export adımlarını izlemeniz gerekmektedir.  

 

Undo (Geri Al) 

Yaptığınız işlemi geri almak için kullanılan komuttur. Komut ikonuna  
tıkladığınızda son yaptığınız işlem geri alınacak ve çiziminiz bir önceki 

halini alacaktır. Komut ikonunun yanında bulunan ok tuşunu tıklarsanız son 

yaptığınız işlemlerin bir listesi karşınıza çıkacaktır. Bu listeden birden fazla 
işlemin ismini seçerek de bu işlemi gerçekleştirebilirsiniz. 

 

Redo (İleri Al) 

Yaptığınız son işleme dönmek için kullanılan komuttur. Bu komuta 
tıkladığınızda Son yaptığınız işleme geri döneceksiniz. Komut ikonunun 

yanında bulunan ok simgesine tıklarsanız işlem listesi çıkacaktır. Bu listeden 

dönmek istediğiniz işlemi seçebilirsiniz. 
 

 

 Standart View (Görüntü) Araç Çubukları 

 

Eskiz sayfanızda oluşturmuş olduğunuz tasarımlara farklı açılardan bakmak için 

ekranda sağ üst köşede bulunan görüntü küpünü kullanabilirsiniz. 

 

 

 

 

 

Top: Üstten Bakış Bottom: Alttan Bakış 

Front: Önden Bakış Back: Arkadan Bakış 

Right: Sağdan Bakış Left: Soldan Bakış 

 

 

 

 



6 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Çizim İçin Düzlem veya Yüzey Seçme 

Modellerin formları bir profilden oluşur. Bu profillere çizim adı verilir. Çizimler 

bir düzlem veya yüzey üzerine çizilir. Çizilen model üzerindeki yüzeylere veya 

daha sonra oluşturulan düzlemlere çizimler yapılabilir. Çizim yapabilmek için 

öncelikle bir düzlem seçmek gerekir. Bu düzlemler X, Y, Z koordinat sistemine 

göre XY, XZ ve YZ düzlemleri olarak isimlendirilmişlerdir. Çizim sayfası 

açıldığında çizim komutlarının birisine tıklandığında Görseldeki şekil ekrana gelir 

ve buradan da istenilen düzlem seçilebilir. Diğer düzlem seçme işlemi ise Tasarım 

Ağacı üzerinden yapılmaktadır. 

 

Isometric Views: Kamerayı önceden tanımlanmış izometrik görünümlere 

döndürmek için ViewCube'ün köşelerini tıklayın. 

Ortographic Views: Kamerayı önceden tanımlanmış ortografik görünümlere 

döndürmek için ViewCube’ün adlandırılmış yüzlerini tıklatın 

Home View: Ana görünüşe dönmek için Home simgesine tıklayın. 

Look At: Seçilen düzleme veya yüzeye ekrana sığdırarak dik bakma 

komutudur.  

Yeni Bir Tasarım Sayfası Açma 

Fusion 360 programını açtığınızda size direkt olarak yeni bir eskiz sayfası açık 

olarak gelecektir. Siz tekrar yeni bir tasarım sayfası açmak istiyorsanız yandaki 

Görselde görüldüğü gibi File > New Design adımlarını takip etmeniz 

gerekmektedir. 

Şekil 1.3: Yeni tasarım sayfası açma 
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Şekil 1.4: Çizim düzlemleri 

 

Sketch (Eskiz) Komutları 

 

 

Sketch Oluşturma: 2 boyutlu eskizler yapmak için araç çubuğundan “Create Sketch” 

simgesine tıklayın. Düzlem seçmek için XY, XZ ve YZ düzlemleri karşınıza gelecektir. 

Hangi düzlemde eskiz oluşturmak istiyorsanız o düzlemi seçin. Eskiz oluştururken 

düzlemsel yüzeyleri de seçebilirsiniz. 

 
Line (Çizgi): Çizgi çizme komutudur. 

 

Rectangle (Dikdörtgen): Bu komut ile dikdörtgenler çizebilirsiniz. Simgenin yanındaki 

ok simgesine tıkladığınızda karşınıza çizebileceğiniz dikdörtgen türleri çıkar. Bunlar; iki 

noktalı dikdörtgen, üç noktalı dikdörtgen ve merkez noktasından çizilen dikdörtgen 

çeşitleridir. 

 

Circle (Daire): Bu komut ile daire profilleri çizebilirsiniz. Dairenin yanında bulunan ok 

simgesine tıkladığınızda farklı daire çizim metotları çıkacaktır. Bunlar; merkez noktadan 

başlayan daire, 2 noktalı daire, üç noktalı daire, iki noktalı teğet daire ve üç noktalı teğet 

dairedir. 

 

Arc (Yay): Bu komut ile yay çizebilirsiniz. Farklı çizim türleri için yanındaki ok 

simgesine tıkladığınızda bir liste çıkacaktır. Bu listede; üç noktalı yay, merkez 

noktasından çizilen yay ve teğet çizilen yay olmak üzere 3 farklı çizim şekli 

bulunmaktadır. 

 

Polygon (Çokgen): Bu komut ile kenar sayısı girerek çokgenler oluşturabilirsiniz. İç 

teğet daireye sahip çokgen, dış teğet çembere sahip çokgen ve kenar çizilerek oluşturulan 

üç farklı çokgen çeşidi bulunmaktadır.  

 

Ellipse (Elips): Bu komut ile dilediğiniz ölçüde elipsler oluşturabilirsiniz. 

 

Slot (Kama Kanalı): Bu komut ile çeşitli çizim türleri ile kama kanalları 

oluşturabilirsiniz. Bu çizim türleri; merkezden merkeze, merkez noktalı, üç noktalı yay, 

merkez noktalı yay ve tüm kama kanlıdır. 
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Spline (Eğri): Bu komut ile eğri çizgileri oluşturabilirsiniz. İki tür eğri biçimi vardır. 

Bunlar; bir dizi noktadan geçen eğri ve kontrol noktaları oluşturularak çizilen eğrilerdir.   

 

Point (Nokta): Eğriler, çizgiler ya da oluşturduğunuz farklı profiller üzerinde noktalar 

Oluşturabilirsiniz.  

 

Text (Yazı): Bu komut ile yazılar oluşturabilirsiniz. Yazı tipini ve boyutunu kendinize 

göre kişiselleştirebilirsiniz. Bu yazılar aynı bir dikdörtgen gibi profil işlevi görür. Bu 

sebeple oluşturduğunuz yazıları katı hale dönüştürebilirsiniz.  

 

Fillet (Radyüs):  Bu komut ile profilinizin köşelerini yuvarlatabilirsiniz. Bunun için 

öncelikle bir köşe veya belirlediğiniz iki kenar seçmelisiniz. Ardından yarıçap değerini 

girip radyüs elde edebilirsiniz.  

 

Trim (Budama): Bu komut ile çizdiğiniz profilleri, eğrileri veya çizgileri belirli bir 

noktaya veya başka profilin başlangıcına kadar budayabilirsiniz. Program otomatik 

olarak budanacak kenarları algılar.  

 

Extend (Uzatma): Bu komut ile seçtiğiniz profil kenarını, eğriyi veya çizgiyi belirli bir 

noktaya kadar uzatır. Extend ile oluşturmuş uzun çizgiler tek bir çizgi oluşturur. Parça 

parça çizgiler halinde uzatmaz.  

 

Offset (Öteleme): Bu komut ile seçtiğiniz profili +/- değerler girerek öteleme işlemi 

yapabilirsiniz. Burada dikkat etmeniz gereken ötelenmiş bir profili bir daha 

öteleyemezsiniz. Öteleme işlemlerini ana parçadan yapmanız gerekmektedir.  

 

Mirror (Aynalama): Bu komut ile profillerinizin simetriğini alabilirsiniz. Bunun için 

öncelikle bir simetri eksenine ihtiyacınız var. Simetri eksenini aynalamak istediğiniz 

profile istediğiniz mesafede çizebilirsiniz.  

 

 

Stop Sketch (Eskizi Bitir): Eskiz sayfasından çıkmak için yukarıda sağ üst köşede 

bulunan yeşil tik sembolüne tıkladığınızda eskiz sayfası sonlanacaktır. Artık profilinizi 

katıya dönüştürebilirsiniz. 

  

 

1.1. Kalınlık-Extrude Komutları 
 

 Ekstrüzyon İle Katı Oluşturma

 

Sketch sayfasından ayrıldıktan sonra sayfanın üstünde araç çubuğunda “Create” bölümü 

bulunmaktadır. Bu bölümde yapmış olduğunuz profilleri katıya dönüştürecek komutlar 

bulunmaktadır.  

 

Extrude komutu burada bulunmaktadır. Extrude komutu altında farklı işlemler yapabilirsiniz. 

Join, Cut, Intersect, New Body ve New Component olmak üzere beş farklı işlem mevcuttur. 

 

Join: Eğer iki farklı tasarım yaptıysanız ve bu tasarımlar kesişiyorsa bunları tek parçaya 

dönüştürmenize yarar. 

 

Cut: Seçtiğiniz profil doğrultusunda kesme işlemini gerçekleştirir.  
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Intersect: Yapmış olduğunuz bir tasarım ile çizmiş olduğunuz profili extrude ile 

kesiştirdiğinizde kesişen parçaları elde tutmanızı sağlar. 

 

New Body: Yeni bir parça olarak tasarlamanızı sağlar. 

 

New Component: Yeni bir montaj dosyası olarak tasarlamanızı sağlar. Bu parçaları sonradan 

montaj dosyasına çevirmeye gerek yoktur.   

 

Şekil 1.5: Ekstrüzyon ile katı oluşturma sembolü 

 

Bir örnek ile ekstrüzyon komutlarını pekiştirelim. Çizim örneğimize başlamadan önce eskiz 

oluşturabilmemiz için düzlem seçmemiz gerekiyor. Bu sebeple çizim için unsur ağacından Origin > 

XY düzlemini seçiyoruz. 

 

Şekil 1.6: Çizim düzleminin seçimi 

 

XY düzlemine sağ tıklayarak “Create Sketch” seçtiğimizde direkt çizim sayfasına 

yönlendirileceksiniz. Sketch komutları içerisinden Circle > Center Diameter Circle seçiyoruz. 

Dairemizin çapını girerek bir daire profili oluşturuyoruz. 
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Şekil 1.7: Bir daire çizimi 

 

“Stop Sketch”e tıklayıp eskiz sayfamızı kapattıktan sonra Create > Extrude seçeneğini 

tıklıyoruz.  

Şekil 1.8: Bir daireye yükseklik verilmesi 
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Extrude komutunu açtığımızda karşımızda bir diyalog kutusu çıkacak. Burada ilk önce 

“Profile” için çizmiş olduğumuz daireyi seçiyoruz. Dairemizi seçtikten sonra Direction (Yön) için 

Two Sides (İki taraf) seçiyoruz. Ardından iki taraf için de mesafe 20.00mm giriyoruz. Operation 

(İşlem) için New Body diyoruz ve parçamızı oluşturuyoruz.  

 

Şekil 1.9: Çizilen bir silindirin görüntüsü 

 

 Ekstrüzyon İle Kesme 

 

Ekstrüzyon ile kesmek için farklı bir komut bulunmamaktadır. Yukarıda da açıklandığı üzere 

Extrude komutu içerisinde işlem olarak “Cut” seçilirse Extrude Cut işlemi gerçekleşmiş olacaktır.  

 

Şekil 1.10: Extrude > Cut İşlemi 



12 

 

 

 

Şekil 1.11: Katı üzerinde çizim düzleminin seçimi 

Bir katı parça üzerinde işlem yapmadan önce, katı parçanın üzerindeki bir düzlemin seçilmesi 

gerekir. Fare silindirin üzerine fare ile sağ tıklayıp “Create Sketch” komutunu seçtiğimizde parça 

üzerine eskiz sayfası açmış oluruz. 

 

 

Şekil 1.12: Bir dikdörtgen çizimi 

Sketch sayfasına geçtikten sonra araç çubuğundan Sketch > Rectangle > Center Rectangle 

adımları izlenerek, merkez noktası silindirimizin merkezi seçilerek X ekseninde 50mm, Y ekseninde 

30mm olacak şekilde dikdörtgen çizelim. Ölçülerin üzerine tıklayıp ölçüleri değiştirebilirsiniz.  
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“Stop Sketch” komutunu seçip eskiz sayfasını kapattıktan sonra Create > Extrude komutunu 

seçiniz.  

 

Şekil 1.13: Bir silindire dikdörtgen kesik oluşturulması 

Extrude komutunun seçilmesiyle açılan diyalog kutusunda kesilecek profil olarak çizdiğiniz 

dikdörtgeni seçin. Distance (mesafe) kutusuna -10mm girin. Program (-) olarak girilen değerlerle 

otomatik olarak kesim işlemini yapacaktır.  

 
Şekil 1.14: Silindirin içine dikdörtgen kesiğin görüntüsü 
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1.2. Dönel-Revolve Komutları 

 Döndürerek Katı Oluşturma

 

Şekil 1.15: Döndürerek Katı Oluşturma sembolü 

 
Şekil 1.16: Ön düzlem seçimi 

Döndürerek katı oluşturmak için bir düzlem seçmek gerekir. Bu çizimde XZ düzlemi 

seçilmiştir. 

 

Şekil 1.17: Bir daire oluşturma 
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Döndürerek katı oluşturmadan önce seçilen düzleme oluşturulacak katının iki boyutlu şekli 

oluşturulur. Bu çizimde çapı 40mm olan bir merkezden çizilen daire komutu ile profil 

oluşturulmuştur. 

 

Şekil 1.18:Döndürme komutuyla katı oluşturulması 

 

Create menüsünden Revolve komutu seçilir. Çıkan diyalog kutusunda profil olarak çizdiğimiz 

daire seçilir. Döndürerek katı oluşturma işleminde dönme ekseni seçilmelidir. Bunun için Axis 

(eksen) seçiminde unsur ağacında Z ekseni seçilir. Angle (döndürme açısı) olarak 360 derece 

yazılırsa silindirimizin ekseni boyunca döndürme ile katı oluşturulmuş olur. 

 
Şekil 1.19: Döndürerek oluşturulmuş parçanın görüntüsü 
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 Döndürme İle Kesme

 
Şekil 1.20: Revolve > Cut işlemi 

 

Şekil 1.21: Ön düzlem seçimi 

 

Döndürme ile kesim için bir düzlem seçmek gerekir. Bu çizimde XZ düzlemi seçilmiştir. 
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Şekil 1.22: Kare profili oluşturma  

 

Döndürme ile kesim oluşturmadan önce seçilen düzleme oluşturulacak katının iki boyutlu 

şekli oluşturulur. Bu çizimde 20X20’lik bir kare oluşturulmuştur. 

 

Şekil 1.23:Revolve > Cut ile kesik oluşturulması 

Revolve komutunun seçilmesiyle açılan diyalog kutusunda profil olarak çizmiş olduğumuz 

20X20’lik kare seçilir. Eksen olarak Z eksenini seçtiğimiz zaman program direkt yapılacak işlemi 
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kesme işlemi olarak algılar. Bunun sebebi 360 derece döndürdüğümüz kare profilin ana parça ile 

kesişmesinden kaynaklanır. Angle (döndürme açısı) istediğiniz şekilde değiştirebilirsiniz.   

 

Şekil 1.24: Döndürerek kesilmiş parçanın görüntüsü 

1.3. “Eğik-Draft” Komutları 
 

 
Şekil 1.25: “Eğik-Draft” sembolü 

 

Şekil 1.26:Draft komutu ile işlem yapılacak yüzeylerin seçimi 
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Araç çubuğundan Modify > Draft komutu seçilir. Draft komutuna tıkladığınız zaman karşınıza 

çıkan diyalog kutusunda sizden öncelikle draft komutunu kullanacağınız yüzeyin hangi düzlemi 

referans alması gerektiği istenecek. Bu sebeple düzlem olarak referans alacağınız düzlemi 

seçmelisiniz. Bu örnekte referans alınılacak yüzey silindirin üst yüzeyi olacak. Faces (yüzeyler) 

seçilirken eğim uygulayacağınız yüzeyleri seçmeniz gerekmektedir. Bu örnek için dikdörtgen 

kesiğinin uzun kenar yüzeyleri seçilmiştir. Eğim derecesi olarak 45 derece girilmiştir.  

 

 
Şekil 1.27: Draft komutunun uygulandığı parçanın görünümü 

 

1.4. “Pah-Chamfer” Komutları 
 

 
Şekil 1.28: Pah-Chamfer sembolü 
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Şekil 1.29: Pah-Chamfer kenar seçimi ve uygulaması 

 

Araç çubuğundan Modify > Chamfer (Pah) komutu seçilir. Açılan diyalog kutusunda pah 

uygulamak istediğiniz kenarı seçiniz. Pah kırma  ölçüsü olarak 5 mm ölçü giriniz.  

 

 

Şekil 1.30: Pah parçanın görüntüsü 
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1.5. “Radyüs-Fillet” Komutları 
 

 
Şekil 1.31: Radyüs - Fillet sembolü 

 

 

Şekil 1.32: Radyus kenarının seçilmesi 

 

Araç çubuğundan Modify > Radyus komutu seçilir. Diyalog kutusunda çıkan Edges (Kenarlar) 

için radyus yapılacak kenar seçilir. Ardından radyus yarıçapı 5mm olarak girilir.  
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Şekil 1.33:Radyus yapılmış parçanın görüntüsü  

 

1.6. “Delik-Hole” Komutları 

 

Şekil 1.34: Delik-Hole sembolü 

 

Şekil 1.35: Delik – Hole noktasının yerinin belirlenmesi 



23 

 

 

Hole komutunu kullanmak için delik açmak istediğiniz yüzey üzerinde zorunlu bir nokta 

olması gerekmemektedir. Komut penceresi açıldığı zaman istediğiniz yere delik delebilirsiniz. Ancak 

belirli bir sabit ve konumu belli bir delik delmek istiyorsanız önce eskiz sayfasına geçerek yüzeyinize 

nokta eklemeniz gerekecektir. Bu örnekte nokta çizilerek deliğin konumu belirlenmiştir. 

 

Öncelikle delik delmek istediğimiz yüzeye fare ile sağ tıklayıp “Create Sketch” seçeneğini 

seçiyoruz. Modelleme sayfası eskiz sayfasına dönüşecektir. Sketch > Point komutuna tıklayınız. 

Ardından noktayı gösterilen biçimde yerleştiriniz 

 

 

Şekil 1.36: Delik – Hole özelliklerinin belirlenmesi 

 

Noktamızı belirledikten sonra Create > Hole komutunu açıyoruz. Karşınıza delik tipinin şekilli 

bir açıklamasıyla diyalog kutusu çıkacaktır. Öncelikli olarak Placement (delik yerleşimi) için From 

Sketch olan simgeyi seçiyoruz. Bunun sebebi biz deliğimizin konumunu az önce eskiz yardımıyla 

nokta atayarak belirledik. Noktamızı seçebilmek için bu simgeye tıkladık. Ardından delik 

uzunluğumuza Distance (Mesafe) olarak seçtik. Delik uzunluğumuzu biz belirlemek istiyoruz. Hole 

Type (Delik tipi) olarak ise Counterbore (Havşa) olarak seçiyoruz. Delik çapımızı 3mm, havşa 

çapımızı 5.50mm, havşa derinliğimizi 2mm ve son olarak uzunluğumuzu da 10 mm olarak 

belirliyoruz. 
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Şekil 1.37: Delik – Hole açılmış parçanın görüntüsü 
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UYGULAMA FAALİYETİ 
Aşağıda 3 boyutlu modeli ve ölçüleri verilmiş parçayı bilgisayarda çiziniz. 

 

 

İşlem Basamakları Öneriler 

 Çizim programınızı bilgisayara 

yükleyiniz. 

 İş giysisi giyiniz. 

 Temiz ve düzenli olunuz. 

 Çizim yapacağınız bilgisayarı çalıştırınız. 
 Autodesk Fusion 360 programını 

kullanıma hazır hale getiriniz. 

 Çizim araç ve gereçlerini hazır hale 

getiriniz. 

 Autodesk Fusion 360 programını açınız. 

 Bilgisayar programını yapılacak 

çizime ve ölçülendirmeye göre 

ayarlayınız. 

 Çizimde kullanmanız gereken araç 

çubuklarını açınız. 

 Bunun için bilgi sayfalarındaki “Araç 

Çubukları” konusunu inceleyiniz. 

UYGULAMA FAALİYETİ-1 
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 Çizimin işlem sırasını belirleyiniz.  Yapacağınız çizim için öncelikle bir işlem 

sırası belirlerseniz çiziminizi daha basit 

yapabilirsiniz. 

 Çizimi kaydediniz.  Yaptığınız çizimi, öğretmeninizin 

söyleyeceği bir klasöre isim vererek 

kaydediniz. 

 Kaydetme işlemini çizime başladığınız 
andan itibaren yapınız ve bunu çiziminiz 

ilerledikçe belli aralıklarla tekrar ediniz. 

 Aşağıdaki gösterilen işlem 

basamaklarını takip ederek resmi 

tamamlayınız. 

 

 

 

 

 

 Ön düzlemde çizim oluşturunuz ve 

parçanın yanda görünmekte olan kısa 

kenarı 50mm uzun kenarı 100mm olacak 

şekilde bir dikdörtgen profil çiziniz.  

 

 

 

 

 

 
 Çizilen “extrude” komutu ile 10mm’lik 

şekildeki gibi kalınlık veriniz. 

 

 

 

 
 Parçanın yanda görünmekte olan yüzeyini 

seçiniz ve bu yüzeyde daire oluşturarak 

yükseklik veriniz. Dairenin merkezinin X 

eksenine olan uzaklığı 50, Y eksenin olan 

uzaklık 25 ve çap 24mm’dir. 
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 Oluşturulan şeklin yeni görüntüsü yandaki hale gelecektir. 

Extrude ile verdiğimiz kalınlığın uzunluğu 50mm’dir.  

 

  

 

 
 Oluşturacağımız parça için silindirin üst 

yüzeyini seçin ve eskiz sayfası açın.  

 

 

 

 

 
 Seçilmiş parçanın üzerine 60mm çapında daire 

çiziniz. Oluşturduğunuz daireye  

extrude komutu ile 20mm’lik kalınlık  

veriniz. 

 

 

 

 

 

 
 Oluşturulan şeklin yeni görüntüsü yandaki hale 

gelecektir. 
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 Parçanın yanda görünmekte olan yüzeyini 

seçiniz ve eskiz sayfası açınız. Bu yüzeyde 

7mm çapında bir daire oluşturunuz. 

 

  

 

 

 
 

 Oluşturulan şekli extrude ile 20mm 

uzunluğunda kesiniz. Yeni görünüm 

yandaki hale gelecektir. 

 

  

 

 

 
 Chamfer komutunu kullanarak dikdörtgenin 

uzun kenarlarını ve dairenin kenarını seçip 

10mm’lik pah kırma işlemini 

gerçekleştiriniz. 
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 Fillet komutunu kullanarak köşeleri 

5mm’lik yuvarlatma işlemini 

gerçekleştiriniz. 

 

  

 

 
 

 Parçanın yanda görünmekte olan yüzeyini 

seçiniz ve bu yüzeyde çizim oluşturunuz. 

Daireleri; dikdörtgenin uzun kenarına 

uzaklığı 15mm, kısa kenarına uzaklığı 10mm 

ve çapı 10mm olacak şekilde daireler çiziniz. 

 

  

 

 

 

 
 Dairelere extrude ile 30mm’lik kalınlık veriniz. 

 Çizimi kaydediniz.  Son olarak kayıt işlemini tekrarlayınız. 

 İş etiğine uygun davranınız. 

 Bilgisayarınızı düzgün bir şekilde 

kapatınız. 
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KONTROL LİSTESİ 

 

Bu faaliyet kapsamında aşağıda listelenen davranışlardan kazandığınız beceriler için Evet, 

kazanamadığınız beceriler için Hayır kutucuğuna (X) işareti koyarak kendinizi değerlendiriniz. 

 

Değerlendirme Ölçütleri Evet Hayır 

1. Çizim araç ve gereçlerini hazır hale getirdiniz mi?   

2. Bilgisayar programını yapılacak çizime ve ölçülendirmeye göre 
ayarladınız mı? 

  

3. Çizimin işlem sırasını belirlediniz mi?   

4. Resmi doğru çizdiniz mi?   

5. Doğrusal-Açısal-Çap-Yarıçap vb. ölçülendirme işlemlerini yaptınız 
mı? 

  

6. Süreyi iyi kullandınız mı?   

 

 

 

DEĞERLENDĠRME 

 

Değerlendirme sonunda “Hayır” şeklindeki cevaplarınızı bir daha gözden geçiriniz. Kendinizi 

yeterli görmüyorsanız, öğrenme faaliyetini tekrar ediniz. Bütün cevaplarınız “Evet” ise “Ölçme ve 

Değerlendirme” ye geçiniz. 
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ÖLÇME VE DEĞERLENDİRME 
Aşağıdaki soruları uygun seçeneği işaretleyerek cevaplandırınız. 

 

1. sembolü hangi komut için kullanılır? 

A) Ekstrüzyon ile katı oluşturma 

B) Radyus ile katı oluşturma 

C) Döndürerek katı oluşturma 
D) Süpürerek katı oluşturma 

E) Eğik-Draft komutu 

 

2. sembolü hangi komut için kullanılır? 

A) Loft ile katı oluşturma 

B) Ekstrüzyon ile kes 

C) Döndürme ile kesme 
D) Hole ile delik oluşturma 

E) Radyus ile katı oluşturma 

 

3. sembolü hangi komut için kullanılır? 

A) Pah 

B) Ekstrüzyon ile katı oluşturma 

C) Draft 

D) Radyus 

E) Yay çizme 
 

4. sembolü hangi komut için kullanılır? 

A) Ekstrüzyon ile katı oluşturma 

B) Süpürerek katı oluşturma 

C) Ekstrüzyon ile kesme 

D) Döndürerek katı oluşturma 

E) Daire çizme 
 

5. sembolü hangi komut için kullanılır? 

A) Pah 

B) Delik 

C) Draft 

D) Radyus 

E) Ekstrüzyon 
  

ÖLÇME VE DEĞERLENDİRME-1 
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6. Merkezi belli yay çizme komutu hangi sembolle kullanılır? 

 

 

A) 

 

 
 

B) 
 

 

 

C) 
 

 

 

D) 

 

 

 

D) 

 

 

 

DEĞERLENDİRME 
 

Cevaplarınızı cevap anahtarıyla karşılaştırınız. Yanlış cevap verdiğiniz ya da cevap verirken 

tereddüt ettiğiniz sorularla ilgili konuları faaliyete geri dönerek tekrarlayınız. Cevaplarınızın tümü 

doğru ise bir sonraki öğrenme faaliyetine geçiniz. 
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ÖĞRENME FAALİYETİ-2 
 

 

 

 

Yüzey modelleme komutlarını doğru kullanarak çizim yapabileceksiniz. 

 

 

 

 

 Sizce yüzey modelleme ve katı modelleme arasında ne tür farklar vardır? Araştırınız. 

 Çevrenizdeki sanayi kuruluşlarını dolaşarak buralarda kullanılan tasarım ve 

modelleme programlarını araştırınız. 

 İşletmelerde kullanılan tasarım ve modelleme programlarında yüzey modelleme 

komutlarını araştırınız. 

 

2.YÜZEY MODELLEME KOMUTLARI 
 

2.1. Patch (Yama) İle Yüzey Modelleme Komutları 
 

Autodesk Fusion 360 programında yüzey modelleme için Patch modülü kullanılır.Patch 

modülüne geçebilmek için program çalışma alanını Model > Patch olarakdeğiştirmeniz 

gerekmektedir. 

 

Şekil 2.1: Çalışma alanının seçimi 

 

 Extrude İle Yüzey Oluşturma 

 

 

Şekil 2.2: Extrude – Ekstrüzyon yüzey modelleme sembolü 

ÖĞRENME FAALİYETİ-2 

ÖĞRENME KAZANIMI 

ARAŞTIRMA 
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Şekil 2.3: Extrude – Ekstrüze komut için çizilen eğrisel profil 

 

Sketch > Spline eskiz komutu seçilerek istenilen yüzeye rastgele bir eğri çizilir. Eğrimizin 

üzerinde oluşan kontrol noktalarından gerekli şekil düzenlemelerini yapabilirsiniz.  

 

Şekil 2.4: Extrude – Ekstrüze komutu ile eğri profilinin seçilmesi 

 

Çizmiş olduğumuz eğrimizin üzerinde extrude komutunu uygulamamız için öncelikle Create 

> Extrude komutu seçilir. Dikkat ederseniz, buradaki komutlar Model çalışma alanında bulunan 

komut simgeleriyle aynı şekildedir. Sadece renk olarak turuncudur. Bu sebeple komutlar arasındaki 

farkı ayırt edebilirsiniz.  

 

Extrude komutunu açtıktan sonra işlem yapılacak profil için çizdiğiniz eğriyi seçin. Mesafe 

olarak 100mm girin ve komuttan çıkın.  
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Şekil 2.5: Exturude - Ekstrüze edilmiş yüzey görüntüsü 

 

 Revolve İle Yüzey Oluşturma 

 

 

Şekil 2.6: Revolve - Döndürme yüzey sembolü 

 

Şekil 2.7: Döndürülmüş yüzey için Spline çizgisi 
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Sketch > Spline komutu seçilir ve istenilen düzlemde eğri çizilir. Aynı yüzeye merkez çizgisi 

çizilir. Kontrol noktalarından gerekli düzenlemeler yapılır. 

 

Şekil 2.8: Revolve – Döndürme komutunun görüntüsü 

 

 

Şekil 2.9: Revolve – Döndürme komutu ile oluşturulmuş yüzey görüntüsü 

 

Çizimi tamamladıktan sonra Create > Revolve komutu seçilir. Çıkan diyalog kutusundan 

döndürülecek profil olarak çizdiğimiz eğri, Axis (döndürme ekseni) olarak ise çizmiş olduğumuz 

eksen çizgisi seçilir. 360 derece döndürme işlemi yapılır.  

 

 

 

  



60 

 

 

 Sweep Komutu İle Yüzey Oluşturma 

 
Şekil 2.10: Sweep - Süpürme sembolü 

 

 

Şekil 2.11: Belli bir doğrultu boyunca süpürülecek olan profil 

Sketch > Spline komutuyla önce ön düzlem üzerine çizim yapılır. Ardından sağ düzlem 

üzerine çizim yapılır. Sweep (Süpürme) komutu seçilir. 

 

 

Şekil 2.12: Sweep – Süpürme işlemi uygulama 

 

Çizimi bitirdikten sonra araç çubuğundan Create > Sweep komutu seçilir. Burada öncelikli 

olarak süpürme işlemi yapmak istediğimiz profil seçilir. Ardından profilimizin gideceği yol/patika 

seçilir. Şeklimizin gidiş yönü paralel ya da dik olarak belirlenir. Bu örnekte paralel olarak seçilmiştir.  
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Şekil 2.13: Sweep – Süpürme ile oluşturulan parça 

 

 Loft Komutu İle Yüzey Oluşturma 

 

Şekil 2.14: Loft ile yüzey oluşturma sembolü 

 

Şekil 2.15: Loft işlemi için daire çizimi 

 

Seçilmiş olan yüzeye bir daire çizilir. Eskiz sayfasından çıktıktan sonra araç çubuğundan 

Construct’a gelinir.  

 

Şekil 2.16: Düzlem ekleme sembolü 
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Construct altında bulunan ok simgesine tıkladığınızda farklı yöntemlerle tasarımınıza; düzlem, 

eksen ve nokta ekleme komutları çıkar. 

 

Şekil 2.17: Oluşturulan düzlemler üzerine profil oluşturulması 

 

Constract  > Offset Plane komutu ile oluşturulan düzlem1’in ana düzlemle arasındaki mesafe 

50mm ve ikinci eklenen düzlemin önceki düzleme olan mesafesi de 50mm olarak ayarlanır.  

 

Düzlemler eklendikten sonra birinci düzleme dikdörtgen, ikinci düzleme ise elips çizilir.  

 

Şekil 2.18: Loft komutunun uygulanması 

 

Çizimleri tamamladıktan sonra araç çubuğundan Create > Loft komutu seçilir. Loft 

komutunun seçilmesiyle bir diyalog kutusu açılır. Birinci bölümde birleştirilmesi istenen profil 

şekilleri seçilir. Eğer çiziminize rehberlik edecek bir yol varsa şekillerin izlemesini istediğiniz ray 

olarak eğri/yol/patika seçimi yapabilirsiniz. Bu örnek için herhangi bir rehber yol bulunmamaktadır. 

Bu sebeple yalnızca profillerin seçilmesi yeterli olacaktır.  
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Şekil 2.19: Loft komutu ile oluşturulmuş parça 

 

2.2. Patch İle Eğrisel Form Oluşturma 

 Eğrilerle Yüzey Oluşturma 

 

Şekil 2.20:  Patch – Yama komut sembolü 

Autodesk Fusion 360 yüzey modelleme komutları arasında bükme, eğme, çökertme veya 

yükseltme gibi ayrıca fazladan komutlar bulunmamaktadır. Bunun yerine çok daha kolayca 

yapabileceğiniz bir Patch (Yama) komutu bulunmaktadır. Bu komut ile farklı düzlemlerde 

oluşturduğunuz  uçları birbirine değen profilleri yama ile yüzey oluşturup istediğiniz şekildeki 

eğrilerle bükme,eğme veya yükseltme gibi işlemleri tekbir komutla oluşturabilirsiniz.  

 
Şekil 2.21: Patch – Yama komutu için çizilmiş eğriler 
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Öncelikle alt düzlem seçilerek orijinden başlayan bir merkez dikdörtgen çizilir. Daha sonra bu 

dikdörtgenin arasında kalan düzlem, ön düzlem, seçeriz. Bükme işlemi yapacağımız için 

dikdörtgenimizin altına spline ile bir bükme rayı çizeriz. Bu rayı kendi oluşturacağınız tasarıma göre 

kişiselleştirebilirsiniz. Bükme işlemi değil de yükseltme işlemi yapacaksanız bu eğriyi dikdörtgenin 

üzerine yapmanız yeterli olacaktır.  

 

 Şekil 2.22: Patch – Yama komutu ile bükme işlemi 

 

Çizimimizi bitirdikten sonra Create > Patch komutunu seçeriz. Karşımıza çıkan diyalog 

kutusunda Boundary Edges (Kaynatılacak Kenarlar) yani yama işlemi yapacağımız kenarları seçeriz. 

Çizdiğiniz dikdörtgenin kenarlarını seçin. Daha sonra Interior Rails (İç Raylar) yani bükme 

işlemimizin izlemesini istediğimiz yolu seçeriz. Bu örnek için dikdörtgenin altına çizmiş olduğumu 

eğriyi seçiniz.  

 

Şekil 2.23: Patch – Yama ile bükme işlemi yapılmış yüzey 
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UYGULAMA FAALİYETİ 

 

 

  

İşlem Basamakları Öneriler 

 
 Yükselterek yüzey oluşturunuz. 

 Extrude komutunu kullanarak bir profile 

yükseklik vererek yüzey oluşturabilirsiniz. 

 
 Döndürerek yüzey oluşturunuz. 

 Revolve komutunu çalıştırarak bir profili bir 

eksen etrafında döndürerek yüzey elde 

edebilirsiniz. 

 

 
 Yol kullanarak yüzey oluşturunuz. 

 Sweep komutundan yararlanarak bir profili, 

bir yola göre süpürerek veya birde yardımcı 

yoldan yararlanarak yüzey oluşturabilirsiniz. 

 

 

 Farklı iki veya daha fazla geometrik 

şekil arasında yüzey oluşturunuz. 

 Loft komutunu kullanarak farklı geometrik 

şekiller arasında yüzeyler 

oluşturabilirsiniz. Aynı zamanda 

yardımcı çizgilerden de 

yararlanabilirsiniz. 

 

 Yama yüzeylerle eğrileri referans 

alarak yükseltme/bükme işlemi 

yapınız. 

 Patch komutunu kullarak oluşturacağınız 

eğrilerin referans yoluna göre çeşitli eğme, 

bükme, çökertme veya yükseltme işleri 

yapabilirsiniz. 

Şekil 2.23: Patch – Yama ile bükme işlemi yapılmış yüzey 

UYGULAMA FAALİYETİ-2 
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KONTROL LİSTESİ 
 

Bu faaliyet kapsamında aşağıda listelenen davranışlardan kazandığınız beceriler için Evet, 

kazanamadığınız beceriler için Hayır kutucuğuna (X) işareti koyarak kendinizi değerlendiriniz. 

 
Değerlendirme Ölçütleri Evet Hayır 

1. Extrude ile yüzey oluşturdunuz mu?   

2. Revolve ile yüzey oluşturdunuz mu?   

3. Sweep yüzey oluşturdunuz mu?   

4. Loft ile yüzey oluşturdunuz mu?   

5. Patch komutunu kullanarak yükseltme/bükme işlemi yaptınız mı?   

 

 

 

DEĞERLENDİRME 
 

Değerlendirme sonunda “Hayır” şeklindeki cevaplarınızı bir daha gözden geçiriniz. Kendinizi 

yeterli görmüyorsanız, öğrenme faaliyetini tekrar ediniz. Bütün cevaplarınız “Evet” ise “Ölçme ve 

Değerlendirme” ye geçiniz. 
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ÖLÇME VE DEĞERLENDİRME 
Aşağıdaki soruları dikkatlice okuyunuz ve doğru seçeneği işaretleyiniz. 

 

1. Aşağıdakilerden hangisi sembolü için kullanılır? 

A) Döndürülmüş yüzey 

B) Süpürülmüş yüzey 

C) Ekstrüze yüzey 
D) Loftlu yüzey 

E) Eğrisel yüzey 

 

2. Aşağıdakilerden hangisi sembolü için kullanılır? 

A) Loftlu yüzey 

B) Döndürülmüş yüzey 

C) Ekstrüze yüzey 
D) Süpürülmüş yüzey 

E) Eğrisel yüzey 

 
 

3. Aşağıdakilerden hangisi sembolü için kullanılır? 

A) Süpürülmüş yüzey 

B) Döndürülmüş yüzey 

C) Ekstrüze yüzey 

D) Loftlu yüzey 

E) Eğrisel yüzey 

 
 

4. Aşağıdakilerden hangisi sembolü için kullanılır? 

A) Ekstrüze yüzey 

B) Loftlu yüzey 

C) Süpürülmüş yüzey 
D) Döndürülmüş yüzey 

E) Eğrisel yüzey 

 

 

 

 

ÖLÇME VE DEĞERLENDİRME-2 
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ÖĞRENME FAALİYETİ-3 
 

 

 

 

Katı-yüzey modellerine uygun gölgelendirme ve kaplama işlemleri yapabileceksiniz. 

 

 

 

 

 Bulunduğunuz sınıfın sahne durumunu tartışınız? 

 Belirlediğiniz sahnenin ne tür değişkenleri vardır? Tespit ediniz. 

 

3. GÖRSELLİK İŞLEMLERİ 
 

3.1. Kaplama Komutları 

 

Şekil 3.1: Kaplama komutu sembolü 

 

Şekil 3.2: Kaplama yapılacak parça 

 

Autodesk Fusion 360 programında malzeme atama ve kaplama yapma farklı iki komuttur. 

Malzeme atamada yapmış olduğunuz tasarımın yapılmış olduğu malzemeyi belirlersiniz. 

Belirlediğiniz malzeme analiz hesaplamalarında büyük önem taşımaktadır. Kaplama yapma ise 

Render denilen yani gerçekçi fotoğraflar ve sahnelerde görünmesini istediğiniz malzemelerdir. Bir 

ürünün ana malzemesi ve kaplaması birbirinden farklı olabilir.  

 

Araç çubuğundan Modify > Appearance komutuna tıkladığınızda kaplama menüsü karşınıza 

çıkacaktır.  

ÖĞRENME FAALİYETİ-3 

ÖĞRENME KAZANIMI 

ARAŞTIRMA 
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Şekil 3.3: Kaplama menüsü 

 

Karşımıza çıkan kaplama menüsünde malzeme listelerini klasörler halinde görebilirsiniz. Bir 

tasarımda kullandığınız kaplamalar In This Design alanında listelenecektir. Ayrıca kaplama yapmak 

istediğiniz yerleri Faces (yüzeyler) Bodies/Components (Parçalar/Bileşenler) olarak ayrı ayrı 

seçebilirsiniz. Örneğin tek bir parçanız var. Bu parçanızın önü kırmızı arkası beyaz olacak. O halde 

Faces kutucuğunu işaretleyip her yüzeye farklı kaplamalar atayabilirsiniz.  

 

 

Şekil 3.4: Kaplama yapılmış parça görüntüsü 
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3.2. Render Çalışma Alanı  
 

Gerçekçi sahne ayarları, gölge ve ışık ayarları için çalışma alanımızı Model > Render olarak 

değiştirmemiz gerekmektedir. Render çalışma alanında tasarımınızın Görsellerini alabileceğiniz, 

kaplama yapabileceğiniz, ışık ve gölge ayarları yapabileceğiniz komutlar bulunmaktadır.  

 

Şekil 3.5: Render çalışma alanına geçmek 

 

Şekil 3.6: Render çalışma alanı ve çalışma yapılacak parça 

 

 Render Komutları 

 

Appearance: Kaplama menüsünün bulunduğu 

komut. 
 

Scene Setting: Sahne ayarlarının, ışık ve gölge 

ayarlarının bulunduğu komut. 
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Decal: Tasarımınızın üzerine Görsel, logo vb. 

etiketlerin ekleneceği komut. 

 

Texture Map Controls: Tasarımınızın üzerindeki 

kaplamanın dağılım yönlerini ayarladığınız komut. 

 

In-canvas Render: Bilgisayarınızın performansını 

kullanarak render başlatma.  
 

In-canvas Render Settings: Render ayarlarının 

bulunduğu komut.  

 

Capture Image: Bilgisayardan render alınan 

tasarımın; render resmini kaydetmek. 

 

Render: Bulut sistemden render almak.       

 
 

3.3. Kaplama Boya ve Renk Özellikleri 
 

 

Şekil 3.7: Boyama ve görsellik komut sembolü 

 

 

Şekil 3.8: Kaplama yapılacak parça ve kaplama menüsü 
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Kaplama yapmak istediğiniz tasarımı açınız. Modify > Appearance > Paint adımlarını 

izleyiniz. Paint klasörü altında boyama seçeneklerini bulacaksınız. Glossy (Parlak), Metal Flake 

(Metal Pul), Metallic (Madeni), Powder Coat Rough (Kaba Toz Boyama) ve Powder Coat Smooth 

(Pürüzsüz Toz Boyama) olmak üzere 5 çeşit boyama bulunmaktadır. 

 

 

Şekil 3.9: Boya kaplama yapımı 

 

Powder Coat Rough > Red seçimini fare ile sürükleyip parçanın üzerine attığınız zaman tüm 

parça seçmiş olduğumuz renk ile kaplanacaktır.   

 

 

Şekil 3.10: Gelişmiş kaplama boya ayarları 
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Bu tasarımda kullanılan malzemeler alanına baktığımızda kırmızı boyamızın eklendiğini 

görüyoruz. Bu kırmızı boyanın üzerine çift tıkladığımızda boyanın ayarları karşımıza çıkar. Boya 

ayarlarını kendi isteğinize göre kişiselleştirebilirsiniz.  

 

 Color Libraries: Renk Kütüphanesi ile istediğiniz rengi 

seçebilirsiniz.  

 Scale: Boyanızın ölçeğini değiştirebilirsiniz.  

 Rotation: Kaplamanızın yönünü değiştirebilirsiniz.  

 Roughness: Pürüzsüzlük ayarını yapabilirsiniz.  

 Reflectance: Yansıma ayarlarını değiştirebilirsiniz.  

 

3.4. Fiziksel Malzeme Kütüphanesi ve Ayarları 
 

Fiziksel malzeme seçimi için araç çubuğundan Modify > Physical Material adımlarını takip 

ediniz. Açılan menüden Iron (Demir) > Iron Cast (Dökme Demir) malzemesini seçip tasarımınızın 

üzerine sürükleyin.  

 

Şekil 3.11: Fiziksel malzeme ekleme ve ayar menüsü 

 

Seçtiğimiz dökme demir malzemenin üzerine çift tıkladığımızda malzemenin özelliklerine 

erişebilirsiniz. Malzemenin teknik ve gelişmiş ayarları burada görünmektedir. Önemli bir ayrıntı ise 

fiziksel materyal komutunu kapattığınızda, tasarım yine kaplama rengine dönüşecektir. Fiziksel 

malzeme görüntü olarak görünmez. Yalnız analiz kısmında fiziksel malzemenizin özellikleri göz 

önünde bulundurulur. 
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UYGULAMA FAALİYETİ 
Aşağıda modeli verilmiş parçayı bilgisayarda katı model olarak çiziniz. 

 

 Parçayı öncelikle ahşap kaplama ile kaplayınız. 

 Parçaya fiziksel materyal çelik malzemesi atayınız.  

 Parçayı mavi olarak boyayınız. 

 
 

İşlem Basamakları Öneriler 

 Çizim programlarını 

bilgisayara yükleyiniz. 

 İş giysisi giyiniz. 

 Temiz ve düzenli olunuz. 

 Çizim yapacağınız bilgisayarı 

çalıştırınız. 

 Çizim araç ve gereçlerini hazır 

hale getiriniz. 

 Autodesk Fusion 360 açıldığında kendinize 

ait yeni bir sayfa açınız. 
 Çizim için gerekli ayarlamaları yapınız. 

 Bilgisayar programını yapılacak 

çizime göre ayarlayınız. 

 Çizimde kullanmanız gereken araç 

çubuklarını yükleyiniz. 
 İlgili konuları gözden geçiriniz. 

 Çizimin işlem sırasını belirleyiniz.  Yapacağınız çizim için öncelikle bir işlem sırası 

belirlerseniz çiziminizi daha 
basit yapabilirsiniz. 

 Spline ile kanca profilini oluşturun.  İlgili konuları tekrar gözden geçiriniz. 

 Dikdörtgen profil oluşturun.  İlgili konuları tekrar gözden geçiriniz. 

 Dikdörtgen profilin kancanın içine 
geçecek şekilde düzlem atayın. O 

düzleme de bir küçük dikdörtgen çizin. 

Dikdörtgenleri Loft ile birleştirin. 

 İlgili konuları tekrar gözden geçiriniz. 

 Dikdörtgen profilin arkasına 10mm’lik 
kalınlık ekleyin. 

 İlgili konuları tekrar gözden geçiriniz. 

 Montaj deliklerini ekleyin.  İlgili konuları tekrar gözden geçiriniz. 

 Gerekli radyusleri verin.  İlgili konuları tekrar gözden geçiriniz. 

UYGULAMA FAALİYETİ-3 
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 Çizimi kaydedin.  Yaptığınız çizimi, öğretmeninizin 

söyleyeceği bir klasöre isim vererek 

kaydediniz.

 Bilgisayarınızı düzgün bir şekilde 

kapatınız.
 Parçayı istenilen şekilde kaplayınız.  İlgili konuları tekrar gözden geçiriniz. 

 Fiziksel materyal atayınız.  İlgili konuları tekrar gözden geçiriniz. 

 Boyama komutunu çalıştırınız.  İlgili konuları tekrar gözden geçiriniz. 

 Resmi kaydediniz.  Öğretmeninizle kontrol ediniz. 

 

 

 

KONTROL LİSTESİ 
 

Bu faaliyet kapsamında aşağıda listelenen davranışlardan kazandığınız beceriler için Evet, 

kazanamadığınız beceriler için Hayır kutucuğuna (X) işareti koyarak kendinizi değerlendiriniz. 

 

Değerlendirme Ölçütleri Evet Hayır 

1. Katı modeli oluşturdunuz mu?   

2. Çıkarılacak unsurları çıkardınız mı?   

3. Köşelere yuvarlatma ve pah kırdınız mı?   

4. Malzemeye uygun kaplamayı verdiniz mi?   

5. Parçaya fiziksel malzeme verdiniz mi?   

6. Boyama özelliklerini uyguladınız mı?   

7. Süreyi iyi kullandınız mı? (2 saat)   

 

 

 

DEĞERLENDİRME 
 

Değerlendirme sonunda “Hayır” şeklindeki cevaplarınızı bir daha gözden geçiriniz. Kendinizi 

yeterli görmüyorsanız, öğrenme faaliyetini tekrar ediniz. Bütün cevaplarınız “Evet” ise “Ölçme ve 

Değerlendirme” ye geçiniz. 
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ÖLÇME VE DEĞERLENDİRME 
Aşağıdaki cümlelerin başında boş bırakılan parantezlere, cümlelerde verilen bilgiler doğru ise D, 

yanlış ise Y yazınız. 

 

1. (…)Kaplama komutunu açmak için araç çubuğundan “Modify > Appearance” seçilir.  

 

2. (…)Bir tasarım için fiziksel materyal seçildiği zaman kaplama yerine de geçer.  

 

3. (…)Kaplama özellikleri değiştirilirken Appearance altında çıkan menüden malzeme seçilir, 

malzemeye tıklanır ve istenen değerler değiştirilir.  

 

4. (…)Biten tasarımın sahne, ışık ve kaplama ayarları için Render çalışma alanına  

geçilmelidir. 

 

5. (…)Fiziksel malzeme menüsünde sadece demir malzemeler vardır.  

 

 

 

DEĞERLENDİRME 

 

Cevaplarınızı cevap anahtarıyla karşılaştırınız. Yanlış cevap verdiğiniz ya da cevap verirken 

tereddüt ettiğiniz sorularla ilgili konuları faaliyete geri dönerek tekrarlayınız. Cevaplarınızın tümü 

doğru ise “Modül Değerlendirme” ye geçiniz. 

ÖLÇME VE DEĞERLENDİRME-3 
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MODÜL DEĞERLENDİRME 
 
Aşağıdaki cümlelerin sonunda boş bırakılan parantezlere, cümlelerde verilen bilgiler doğru ise 

D, yanlış ise Y yazınız. 

 

1. (…)Parça dosyası: İki boyutlu çizimin üç boyutlu haline dönüştürülmüş dosyadır. 

 

2. (…)Çizim yapabilmek için düzleme gerek yoktur.  
 

 

3. (…)               Eskizi bitirme komutudur. 

 

 

4. (…) Create bölümünde; yapmış olduğumuz iki boyutlu profilleri 3 boyutlu katıya 

dönüştürebileceğimiz komutlar bulunmaktadır. 

 

5. (…)        Yay çizme sembolüdür. 

6. (…)  Revolve sembolüdür. 

7. (…) Radyüs - Fillet sembolüdür. 

8. (…)  Delik delme komutudur. 

9. (…) Açık ya da kapalı bir profili, bir yol üstünde sürükleyerek bir yüzey unsuru 

oluşturur. 

 

10. (…)    Parça kaplamada malzemelerin özelliklerini değiştiremezsiniz.

MODÜL DEĞERLENDİRME 



73 

 

 

 

CEVAP ANAHTARI 
ÖĞRENME FAALİYETİ-1’İN CEVAP ANAHTARI 

 
1 A 

2 D 

3 C 

4 D 

5 D 

6 A 

 

 

ÖĞRENME FAALİYETİ-2’NİN CEVAP ANAHTARI 
 

1 C 

2 B 

3 A 

4 B 

 

 

ÖĞRENME FAALİYETİ-3’ÜN CEVAP ANAHTARI 
 

1 Doğru 

2 Yanlış 

3 Doğru 

4 Doğru 

5 Yanlış 

 

 

MODÜL DEĞERLENDİRMENİN CEVAP ANAHTARI 
 

1 Doğru 

2 Yanlış 

3 Doğru 

4 Doğru 

5 Yanlış 
6 Doğru 

7 Yanlış 

8 Doğru 

9 Doğru 

10 Yanlış 

CEVAP ANAHTARI 
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